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General Meetings are held
from 8:30am till Noon on:

For  details see pages inside this
issue also check the Web Site @

www.ocipug.org

Feb 25 ‘06
Mar 25 ‘06
Apr 22 ‘06
May 27 ‘06
Jun 24 ‘06
Jul 22 ‘06

Aug 26, ‘06

The Executive Board
meets at Noon on:

Jan 28 ‘06
Feb 25 ‘06
Mar 25 ‘06
Apr 22 ‘06
May 27 ‘06
Jun 24 ‘06
Jul 22 ‘06

All  current OCIPUG members
in good standing are welcome

Special Interest Group (S.I.G.)
meetings are held monthly 

as follows:

1st   Tuesday   Internet
2nd Tuesday   Hardware
3rd Tuesday   Windows
4th Tuesday   Digital Photo

All S.I.G.’s start at 7:00 pm

February 14, 2006
Hardware - 2nd Tuesday 7:00 pm

Ed Leckliter - eleckliter@adelphia.net

February 28, 2006
Digital Photo - 4th Tuesday 7:00 pm
David Wintle - allart@pacbell.net

S. I. G.   M e e t i n g s

SCHEDULES of MEETINGS

February 7, 2006
Internet - 1st Tuesday 7:00 pm

Steve Shiffman

February 21, 2006
Windows 3rd Tuesday 7:00 PM

Robert Strader - robert.strader@comcast.net

     President 	 David Wintle	 949-548-7994	 president.bod@ocipug.org  
	 Vice President 	 Robert Strader	 949-646-1475	 vicepres.bod@ocipug.org
	 Secretary 	 Frank Mastroly	 714-960-9472	 secretary.bod@ocipug.org	
     CFO/Treasurer  	 Shirley England	 949-454-0158	 treasurer.bod@ocipug.org

     Director-2005-6 	 Morris Fier	 949-646-8292	 director4.bod@ocipug.org
     Director-2004-6	 Eugenia Frerichs	 949-548-0413	 director1.bod@ocipug.org
	 Director-2004-6	 Mark Borison	 714-963-8296	 director2.bod@ocipug.org
	 Past President 	 Leonard Stein 	 949-454-0158	 pastpres.bod@ocipug.org
	 Long Range Planning	 Leonard Stein 	 949-454-0158	 pastpres.bod@ocipug.org
     

     Readme.Doc Editor 	 Robert Walker	 949-642-5997	 editor@ocipug.org  
     Web Master                      Mark Borison	 714-963-8296             webmaster@ocipug.org
	 Programs	 David Wintle	 949-548-7994	 prgm@ocipug.org
	 SIG Coordinator 	 Robert Strader	 949-646-1475	 sigcoordinator@ocipug.org
     APCUG rep	 Robert Strader	 949-646-1475	 apcugrep@ocipug.org

LEADERS

March 25,2006

April 22, 2006

May 27, 2006

June 24, 2006

TBA

TBA

TBA

TBA
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pRESENTATION
Jim Kelton is a leading information technology consultant with 
25 years of management and technical experience.  

Jim graduated first in his class with a Master of Science degree 
from one of the top 5 MIS schools in the nation.  Beginning his 
career, Jim was recruited by the #2 computer manufacturer in 
the United States.  After several years, he was selected by a 
subsidiary of a Fortune 10 company to serve as their CIO.

Jim is President of Altius Information Technologies, a southern 
California based IT consulting firm.  Jim is past president of NetTeCH, a nationwide as-
sociation of IT related companies.  In addition to his leadership in the IT arena, he is past 
president of the Association of Professional Consultants.

As a leading IT authority, Jim has authored and appeared in over 40 publications includ-
ing the Wall Street Journal, Business Week, USA Today, the Los Angeles Times, and 
many others. Jim is an expert commentator and frequently appears on nationwide televi-
sion including MSNBC.

Topic: What hackers know that you don’t
Hackers, cyber attacks, security risks, threats, and vulnerabilities, are you ever really 
secure?  Find out how organizations improve quality by Identifying and managing their 
security risks.

In this session you’ll...

Learn why security is a game
Find out who is winning the game – hackers have the time, you have the 
money
Learn about new security legislation and what you need to do to be prepared
Find out why security vulnerabilities are cumulative
Discover how 99.9% secure translates to 3.5 days of vulnerability per year
Find out when you are most vulnerable to an attack
Identify steps you need to take now, before it is too late










Jim Kelton Speaker Introduction
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REPORTS of MEETINGS

Happy Valentine. Since this is the month of valentines and lovers be sure some one you would love to 
hate has not been in your computer. Be at the general meeting on Saturday the 25th of this month. The 
program will be on keeping your not friendly hacker out of your computer. If a hacker has paid you a 
visit you will need this information to stop his return after you send him packing.

January 26 has passed so you should now have all the forms required to start getting ready for tax day. 
Latt months Readme.doc had an article about TaxCut and their discount to user group members. There 
are some discount counts and special purchases of TaxCut and aTurboTax is most of the computer and 
stationary stores. April 15 arrives very quickly. Those that have been taxes for many years, Senior citi-
zens, can set an appointment at the Costa Mesa Senior Center’s front desk to have a tax person help 
you.

As a reminder we need someone to take notes during the general meeting. Those that are not sure of 
when your dues are due please check with Warren Bradford. Anyone that has changed their e-mail ad-
dress should also check with Warren. As of April 1, 2006 those persons that are not current with their 
dues will no longer receive the Readme.doc. The current and 2 prior issues of the Readme.doc will not 
be on the OCIPUG web site. The web site members ONLY section now requires a password for access. 
This month the password is “valentine”. 

We are still looking for presenter for the general meetings. Presenters from manufacturers and venders 
are becoming harder to schedule. They need to justify the cost by increasing sales. Years ago getting the 
information out was in a great part by word of mouth, ie User Groups. With the advent of the internet 
advertising has become much less expensive. We are still able to ask for and receive presentations for 
vendors as PIB, (presentation in a box). The PIB’s do require someone from the group to do the physical 
presentation. Any member that would like to do a presentation either one that they are familiar with or 
may like to do only needs to ask. I know we all use various programs and could do a PIB of one of the 
programs you use.

As has been stated in many meeting by officers and members, the need for volunteers is still one thing 
that has been very lax. We will be making up a slate of new officers in a few months. The present officers 
are either ineligible or will not be available to be re-elected. It is very simple, no officers-no OCIPUG.
This is your club and part of belonging is to be involved. I have heard persons say that “All organizations 
are getting smaller.” I believe this happens because the membership does not wish to be involved in the 
organization. They only want to attend to either hopefully learn something or be entertained. With the 
computer we can do both, but it takes participation and involvement from the membership.

OK I am off my soapbox. Have a great Valentine’s Day.

See you on Saturday the 25th.

David Wintle
President
Readme.Doc co-editor
Program Committee
Digital Photo SIG Leader

Presidents Message
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WINDOWS S.I.G.

Robert G. Strader Windows SIG Leader

INTERNET S.I.G.
Steve Schiffman Internet SIG Leader

HARDWARE S.I.G.

Ed Leckliter Hardware SIG Leader

DIGITAL PHOTO S.I.G.

David Wintle Digital Photo SIG Leader

In this SIG we not only cover the Internet, we 
also cover Networking. Please write your ques-
tions down and bring them to the meeting. You 
may also e-mail your questions to prior to the 
meeting.  

The March  SIG will be mostly on searching the 
internet. Tips and Tricks will also be discused.

The March SIG will be on Tuesday March 7th, 
2006

The February Digital SIG will have a discus-
sion on some of the differences between Ado-
be Photoshop Elements 3 and 4. We will look 
at a few tutorials on correcting items in photos. 
We will also look at correcting the color using 
curves by Curvemeister an add-in  to photo-
shop programs.

The March SIG will be on Tuesday March 28th, 
2006

OCIPUG Hardware SIG - Meeting Recap 

Meeting Date: January 10, 2006

There were only 8 attendees (including SIG Leader, 
Ed Leckliter).  [Interest level declining? Worth the 
time?]

Featured Topic(s): Your New System (2006 Up-
date) - Planning Phase 

Hardware Submissions:  None

Random Access:  None

Next Meeting: February 14, 2006

Next Meeting Featured Topic(s): Your New System 
(2006 Update) - Sourcing Your Components

Following Meeting: March 14, 2006

Following Meeting Featured Topic(s): Your New 
System (2006 Update) - Setting Up/Installing Your 
Motherboard, CPU, and System RAM
File(s) :

    Presentation slides in Microsoft PowerPoint for-
mat (.ppt).  

    NOTE: PowerPoint presentations are also posted 
on the OCIPUG Hardware SIG web site (http://
www.edscustomcomputers.com/welcome_to_the_
ocipug_hardware_sl.htm)  

For the latest OCIPUG Hardware SIG info, please 
check the SIG’s web site or contact Ed Leckliter 
(SIG Leader) at eleckliter@adelphia.net.

The March SIG will be on Tuesday March 14th, 
2006

gd

The February SIG was on System Security, and 
Spyware. Questions from the attendees was dis-
cused also.

Bring or send your questions.

The March SIG will be on Tuesday March 21st
, 2006

e

g
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Microsoft Digital Image Suite 10 (DIS10) has two major parts:  Digital Im-
age Pro10 (DIP10),  an image editor and browser evolving from Picture 
It!, and Digital Image Library, an image organizer and cataloguer as dis-
tinguished from a browser.  Photo Story 2, a video and slide show creator, 
is bundled with DIS10, although it is also available as a free download.

I love Digital Image Suite 10. I love its simplicity. I love its rhythmic man-
tra: Click Click Done!  Click Click Done! Like a dance step, but you don’t 
need  lessons from Madam Lazonga. DIS10 will get you doing the tango 
instinctively first time out!

Human engineering has been given top priority in developing the DIS 
GUI. Aware that we mortals are prone to search high and low for our 
spectacles when we are wearing them, the designers put the instructions 
where we will always find them—in a panel, maybe 2 inches wide, im-
mediately left of the image. For a given operation, all the instructions and 
settable parameters to carry it out can be found there. Changing as the 
task or subtask changes, the context is always concise.

DIS10’s instruction panel has educational value as well. It allows you to 
correlate tool functions with image effects. Auto Fix options are good 
examples. If invoked under one of  Touchup’s submenus, you see the  
manual adjustments you would have to perform to get the same result. 
The understanding thus derived cannot but help in applying the fix intel-
ligently, and in knowing when and how you might do better manually.

The Levels and Curves instruction panel is another example of how DIS10 
correlates tool effects for you. Because these tools have been combined 
in a single graphic, curve adjustments corresponding to movements of 
the sliders are vividly revealed. Although the  midtone Levels (gamma) 
slider appearing in Adobe Photoshop is missing, the effect of that slider 
can be reproduced in DIS10 by dragging the curve to form the upward or 
downward arc of a power curve. Ditching the gamma slider, then,  need 
not be regretted. because Curves can do everything that Levels can do 
(and so much more).

Panoramic Stitching will make a composite of all open images, provided 
it detects overlapping among them. With my camera on a tripod, I  took 
5 photos of a mountain range, swinging from due west to due east. All 
I had to do was open the images in DIS10 and click Tools>Panorama 
Stitching. With no intervention on my part, the five shots became one 
seamless composite—there were no visible interfaces between any of the 

A Review 
by GEORGE AUSTIN a member of OCIPUG

Microsoft Digital 
Image Suite 10
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original photos. The same photos could not be composited using PSCS2’s 
Photomerge operation. It’s automatic process came to a halt and called 
for manual intervention.

Along with Panoramic Stitching, the DIS10 Tools menu comes up with 
several innovative special effects. For a specific number of times or con-
tinuously, and at a size and rate you are prompted to specify, Flipbook will 
flip through open files and  Web Animation will rotate, scroll or fade an im-
age. If Snap Rotation is enabled, it will exactly orient objects horizontally, 
vertically, or at 45 degrees as you approach those orientations within a 
few degrees. If you don’t want it to do so, simply keep it disabled.

File>Create a Project and File>Create a Photo Collage have a snappy 
way of fitting your images into pre-defined contours. You are presented 
with templates containing fixed open shapes (rectangles, circles, ellipses, 
hearts, stars, etc). Each image is wrapped in a selection box with side 
and corner handles to change size and aspect ratio, and it can be moved 
about by dragging. You are thus able to fill any given shape with any por-
tion of any image despite initial size mismatches--- rapidly zooming and 
scrolling the contents while the fixed-size frame does the cropping.

You can add text to your images using a text box also with handles allow-
ing rotation, expansion, and  placement. Typeface, font size, color, bold-
ing, italicizing, and underlining are all selectable, but there are no special 
characters and no superscripting, subscripting, kerning or leading. There 
are some 28 textured, artistic, and “fun” text effects —a bit gimmicky, but 
in the textured category, I found Crackled Stone to be perfect for caption-
ing bald, stony desert mountain scenes.

DIS10 gives more freedom than Photoshop in manipulating marquee 
shapes (the shapes themselves, sans content). In PS, once the selection 
is created and the mouse button released, you can no longer change its 
shape. In DIS10, you are able to change a selection’s aspect ratio even 
after releasing the mouse button. Clicking “Adjust Marquee” in the dialog 
box provides handles to reshape the selection and also provides a han-
dle on top to rotate it (yes, rotate the selection contour!). Furthermore, 
DIS10 provides an array of 67 marquee shapes to choose from and fills 
them with a semi-transparent film for better visualization during their 
formation.

The DIS10 crop tool does not have a resampling option. The original’s 
resolution is retained. The tool acts like a scissors, cutting out a rectangle 
from the original without changing any of the pixels within. You define 
and position the rectangle, literally framing the area to be cut out. You 
don’t get to enlarge or compress it as in PS, but that can be done in 
a subsequent image resizing operation with or without resampling via 
Format>Resize Image.

Continued on Page # 8
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DIS10’s Smart Erase gives instant gratification to an absolute beginner, 
who can use this very sophisticated feature immediately, without reading 
the manual. See something you don’t want in the picture? Click Smart 
Erase. DIS10 switches the cursor to the proper tool and succinctly il-
lustrates what to do with it---trace a closed path (which can be crude) 
around the item, click Fill In and then click Done. The item disappears and 
the space it occupied is miraculously filled in to match the surroundings.

Adding Flash and Reducing Backlighting features are provided to correct 
for under- or over-exposure when the subject and background illumina-
tions differ markedly, but it is difficult to isolate shadows, midtones, and 
highlights with it. PSCS2’s Shadow/Highlight adjustment does a much 
better job at this, since it is more than a simple input/output curve ad-
juster.

I easily and very effectively corrected a color cast on a night photo of a 
lighted pool in which the water came out decidedly green. Using the eye-
dropper provided via Touchup>Color and Saturation, I merely clicked on 
a  gray area found in the background. The pool was restored to a beauti-
ful blue color. How did I know I should click on a neutral spot? DIS10 told 
me what to do, as it does in all of these operations.

An otherwise cute flash photo of my 4-year-old grandson peering over 
the edge of a bathtub was spoiled by his piercing red pupils.  By merely 
going to Touchup>Fix Red Eye and clicking each eye once, as directed by 
DIS10, his pupils were immediately blackened. I needed no further cor-
rections, but if I had, sliders to tweak the intensity and size of the correc-
tion were proffered. I have seen this DIS10 feature disparaged in other 
reviews, but I find it does well if you don’t overdo the blackening. 

The beam on top of a very long sliding door was tilted noticeably in an in-
terior photo of mine. From Format>Straighten Picture, I followed DIS10’s 
orders and clicked near the two ends of the beam. The image rotated 
to reorient the beam horizontally. I had the automatic cropping option 
checked, so the empty wedge-shaped edges of the photo produced by 
the rotation were trimmed as well. If I had chosen an off-vertical door 
jamb instead of the beam, the image would have rotated through the 
shorter angle to make the jamb vertical.

The latter operation typifies how a DIS10 newbie can perform tasks right 
out of the box, because the descriptive language used  is so intuitive and 
the prompting so germane. Compare the same operation in Photoshop. 
The Photoshop user has to be aware that there is a Measure tool (hidden 
behind the Eyedropper tool on the Tool bar). He will eventually learn that 
one of the things it measures is the elevation angle of a line created be-
tween two click points. What he won’t immediately realize is that this an-
gle is automatically entered for him in a dialog box under Image>Rotate 
Canvas>Arbitrary and that, if he goes there, and clicks OK, the image 

Continued from Page # 7
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can be rotated back through that angle. Nowhere is the word “straighten” 
used and there are no prompts telling him what to do.

Repeat the foregoing scenario for dozens of operations and you’ll under-
stand why there is a vast learning curve difference between PS and DIS. 
On the other hand, having once learned these operations in Photoshop, 
I would not for one moment give up their additional versatility. The PS 
Measure tool, for instance, not only gives me the angle between click 
points but also the x and y coordinates of the first point, the straight line 
distance to the second click point, and the delta-x and delta-y distances.

DIS10 allows independent “objects” to be separately edited and positioned 
on the background. You can switch back and forth between grouping mul-
tiple objects for simultaneous editing and movement, or ungrouping for 
individual action. The objects are essentially layers, but it was disappoint-
ing to find so little interactive blending capability between layers.

Whereas PSCS2 provides twenty four blending modes, in DIS10 you can 
only get the equivalent of one—the “Normal” blend. You get that via Effec
ts>Transparency>Even, allowing you to set the transparency of an object 
to any value between 0 and 100%, essentially controlling the relative mix 
of object and substrate color values. Sorry, folks, there are none of those 
wonderful Photoshop blending options like  Multiply, Screen, Overlay, Soft 
Light, etc. And there is no layer masking.

DIS10’s  “Blending Brush” is an alternative to its clone tool, which cop-
ies pixels from one location to another. Instead of replacing pixels, this 
blending brush mixes them. There are no options, no parameters. The 
algorithm is nowhere revealed in the documentation. As near as I can tell, 
it’s a normal blend at a fixed source transparency of 82%, so the result-
ing value appears to be an 18/82 percentage mix of source and target  
values.

Photo Story is invoked from the options bar in Digital Image Library. You 
need Windows XP and Windows Media Player 9 to create slide shows us-
ing Photo Story. You can then put them on a VCD playable on many DVD 
players. It is hard to believe how effortlessly you can create slide shows 
with it, complete with background music and voice-over commentary.

When you open the images to be shown, they appear in a film strip at 
the bottom of the screen. You rearrange them either by dragging them 
individually into position or by clicking an arrow which moves selected 
frames one position per click . If narrating, you determine the dwell time 
for each frame by the interval you allow before clicking the Next button, 
else you specify the time.

Photo Story takes it from there, mixing up what it does with each frame—
zooming in, zooming out, scrolling up or scrolling down--- using a focal 

Continued on Page # 10



February 2006
ORANGE COAST IBM PC USER GROUP

Readme.doc ver 22.02

10

point you can designate by cursor positioning while narrating. Locating 
and playing your slide shows is a no-brainer: Go to My Documents and 
click My Videos. Photo story has listed them right there for you. Double-
click on your choice, then sit back and enjoy! It’s so intuitive, my ten-year-
old granddaughter has become an instant producer with it and seems to 
be having career fantasies.

Digital Image Library is a data base program allowing you to organize 
your images into virtual rather than physical groups. It can present their 
thumbnails and metadata without accessing them. Thus, if you have im-
ages stored on, say, 100 CDs, and you need to browse their content, you 
can do so without (good grief!) having to insert them successively in the 
CD drive. Library will display their thumbnails and disclose their locations 
by the name or number identifier you assigned to the disk. When you 
find the images you’re looking for, you know what disks to insert to get 
at them.

If your CD contains PSD files, however, Library will not recognize them. It 
will proceed with other files and behave as though the PSD files did not 
exist. This is an unexpected shortcoming, inasmuch as DIS10 is touted as 
supporting PSD format. In reality, the editor (DIP10) can view PSD files 
but not save in that format, and Digital Image Library cannot view files 
the editor cannot save. That’s a somewhat convoluted explanation, but 
it’s right out of the Digital Image Library Help file.

Library can group your images by category, and images can appear in 
multiple categories even though the image physically exists in only one 
place. You don’t need a replica in each group. Library points in each case 
to the same single storage location, be it on your computer or on remov-
able media. And, as you probably have guessed,  Library can filter your 
entire collection to show only those matching the date or the keywords or 
ratings you assigned. Give me all images of Brian, let’s say, or all sunsets, 
or all images rated as wall hangers.

DIS10 is a vast program. It is impossible to comprehensively cite its many 
features in a short review. I have given some of my reactions after a 
quick look. Its designers have made such an art form of reducing com-
plexity, DIS might more aptly stand for Digital Imaging Simplified. Until 
you’re ready for all the nuances of Photoshop CS2 or even Photoshop 
Elements,   DIS10 brings you up to speed on basics a lot more painlessly. 
Even when you are a Photoshop sophisticate, however, you’ll appreciate 
having DIS10 around to do chores fuzzied by  your rusty memory, or for 
teaching fundamental editing skills. It’s affordable (list $124, street well 
under $100) and, oh yes, did I mention how easy it is to use?

Continued from Page # 15

gg
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Is the Internet Insecure 
Because of You?

By Dave Gerber, APCUG Advisor; radio show host; Vice 
President, Sarasota PCUG, Florida
dgerber(at)apcug.net

Long gone are the days that we could feel secure 
and know for certain that we had privacy. With the 
digital age upon us we can no longer be so sure that 
our privacy is secure. Recently Google has admit-
ted their organization holds user data indefinitely. 
This causes concerns as now we know Google has 
information on us that we do not want anyone to 
know about.

We can simply blame this all on the big corporate 
companies; they seem to be a very good escape goat 
however, this is not the case; your privacy is totally 
up to you. Certificates ensure that all the data that 
is transferred between you and the internet is secure 
and encrypted. Recently in New Zealand there was 
a short certificate outage on a banks website. Dur-
ing this outage only one out of 300 users took this 
security warning seriously.

This is a rather large concern, as many users on the 
internet have the same belief that their data is safe 
and secure. By the end of 2005 it is estimated iden-
tity fraud will cause up to 5 trillion dollars world 
wide. We, the users of the internet must keep our-
selves safe, secure and pay attention to those secu-
rity warnings. I have compiled some good tools and 
tricks that will help keep you much more anony-
mous and secure.

1) Get rid of the internet explorer:

First and foremost Microsoft Internet Explorer is 
the highest risk to your internet experience. Not 
only is the most popular internet browser, but is 
also the most popular for attacks from Viruses and 
Spyware. Internet explorer is also too integrated 
with the windows operating system. Have you ever 
wondered how a dialer or online casino got onto 
your desktop?

I personally recommend Opera; they have a nice 

clean browser. The usability is easy and best of all, 
it uses tabbed browsing.

2) Protect your Connection.

Make sure you have an active firewall operating; 
Firewalls stop intruders from entering your con-
nection and causing havoc. Hackers can easily gain 
access to an unprotected network and steal private 
information.

With the release of SP2 for Windows XP, Microsoft 
has incorporated a free personal Firewall. If you 
have broadband your router should have an inbuilt 
Firewall, and make sure this is enabled, Zone Alarm 
also offer a free Firewall. You must always do what 
you can to protect yourself.

3) Don’t share those files:

One of the most common security flaws besides run-
ning Windows XP, is having File sharing enabled. 
To disable File Sharing please do the following:

Click Start Menu, select settings.

Click on Network Connections.

Right-click on the Local Area Connection icon and 
on the menu that appears, choose Properties.

In the General tab under “This connection uses the 
following items”, highlight “File and Printer Shar-
ing for Microsoft Networks”. (If File and Printer 
Sharing is not listed, then file sharing has not been 
setup). You may skip the rest of these instructions.

Click Uninstall.

When you are asked if you are sure you want to Un-
install File and Printer Sharing Click Yes.

You may now close the Local Area Connection 
Properties window.

You must restart for your computer for the effects 
to work.

Continued on Page # 12
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3) Hide your IP address:

Your IP address is just like your phone number, it 
links directly back to you. There are many reasons 
you may wish to hide your IP address. Preferable 
you do not want to be tracked around the web, it’s 
just as bad as having a GPS in your mobile phone.

4) Check those certificates:

Your internet connection is not secure, the data that 
travels between you and the site you may be brows-
ing may pass through over 25 other computers. If 
you are sending very confidential information such 
as credit card payments, make sure the address starts 
with an https. Also check that the padlock on your 
browser is locked, and is valid for the specific site. 
This will ensure that you have a 128 bit encrypted 
connection with the website.

If you want secure email you may also have your 
emails encrypted too. A good free vendor is Hush-
mail. Your email security is more at risk than your 
web browsing; you must ensure your emails are 
safe.

5) Kill the spyware

Spyware are little programs that can easily be 
picked up by surfing any website or downloading 
files. Spyware can pickup information from where 
you surf to your credit card details, this information 
then can be sold.

Microsoft has released a beta version of their up-
coming anti spyware removal tool. This too works 
well, and I highly recommend this tool. Zone Alarm 
also offer a free online spyware detector.

The information I have passed to you should be se-
riously considered. The internet is a very unsecure 
environment; you must ensure your data is safe 
from outside prying eyes. Make sure you are careful 
with any transaction you make. Never fool for any 
kind of email promotion, anyone who tries to sell 
to you through spam advertising is not trustworthy. 

Also make sure to check the links from anything 
you click on; I have found numerous fake Paypal 
sites that try to steal your login and password.

Remember... it is up to you
 
There is no restriction against any non-profit group 
using this article as long as it is kept in context with 
proper credit given the author.  The Editorial Com-
mittee of the Association of Personal Computer 
User Groups (APCUG), an international organiza-
tion of which this group is a member, brings this 
article to you.

The Mouse from Hell
Hardware Review…or Sort of
By Ann Moore, Topeka PC Users Club
Personal Computer Newsletter, February 
2006
www.topekapcusersclub.org
commuter(at)cox.net

Several months ago, I sent the fol-
lowing e-mail to “Answerperson” 
concerning a tragedy in my life:

“Dear Answerperson,
When I started my computer this 
morning, my mouse showed no sign of 
life.  Its heart (red light) did not 
flicker nor did it feel warm to my 
touch.  It was stone cold dead.  I 
tried to revive it by performing an 
uninstall-reinstall, to no avail.  
A check of outlets and wiring found 
them intact.  How do I determine 
the cause of death?  There were 
no early signs of malfunction.  If 
it were an animal, I could have a 
necropsy performed.  Must I disas-
semble it to determine the cause of 
death?  I cringe at the thought of 
disemboweling my friend.  My mouse 
was not extraordinary in any way – 
it was not wireless nor was it er-
gonomic, just a simple mouse that I 

Continued from Page # 7
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loved and cherished.  Every day for 
four year, I held this inanimate 
object in my hand, caressed it, and 
knew every curve and indentation 
intimately. We were as one.

I have accepted the fact that I 
must now lay it to rest, but where?  
Is there a cemetery for computer 
mice?  Should I have it cremated or 
do I put it in a box and bury it in 
my backyard under the lilac bush?  
What will become of my dear friend?  
Is there a computer mouse heaven?  
This has never happened to me be-
fore and I am devastated.  Please 
no cards or flowers.  There will be 
a memorial fund set up in the name 
of “Ann’s Mouse” and donations may 
be sent to commuter(at)cox.net”

Answerperson offered his deepest 
sympathy and suggested that I put 
my sorrow behind me, go on with my 
computing and find a new mouse.  I 
visited Best buy in search of a 
replacement and found no sympathy 
there.  Their only concern was to 
sell me a very expensive replace-
ment.  In my vulnerable state, if 
the clerk had shown a little com-
passion, I might have purchased a 
more expensive model but because 
his attitude was cold and unfeel-
ing, I left the store with one of 
their cheapest models.  There is an 
old adage:  “You get what you pay 
for,” and that is exactly what I 
got – in spades.

I doted on my new mouse, shower-
ing it with an abundance of TLC.  
I never mistreated it by applying 
any unnecessary pressure, jerking 
or pulling.  In spite of all my ef-
forts to maintain a close personal 
relationship, it soon became ap-
parent that we were not compatible.  
The erratic behavior of the mouse 

became noticeable following sur-
gery on my right shoulder.  I was 
forced to change the mouse settings 
to accommodate my left hand and the 
mouse began to balk at every com-
mand.  Although I moved it around 
very slowly, it would take off and 
race around the screen leaving me 
breathless in my attempt to keep up 
with it.

In October, I purchased a new LDS 
19-inch monitor and the mouse went 
ballistic.  It refused to leave the 
confines of its colorful, soft pad.  
Trying to reach the far corners of 
my monitor with my cursor became 
almost impossible.  The mouse re-
sisted my every effort to control 
its actions.  Every day was a tug-
of-war and I was losing my patience.  
I had serious work to do and no time 
to play games.  I needed a good re-
liable mouse.  I decided that this 
obnoxious, malevolent, detestable 
little rodent had to be eradicated.  
It was time to go cordless.

Completing a jubilant trip to Best 
Buy, I came home with a Logitech 
cordless mouse.  I could hardly 
wait to start using it.  What a 
different a cord makes!  This Logi-
tech moves like a dream and is a 
pleasure to work with.  It takes me 
everywhere I went to go.  Truly, a 
match made in heaven.  I am certain 
that I have found a new reliable 
friend.

What do I do with this evil, ma-
licious, wicked little devil that 
made my life a living hell?  No 
sad songs or mourning for this mon-
ster.  I had visions of snipping off 
its tail to make it impotent, then 
dropping it on the floor and stomp-
ing it to death.  I even considered 

Continued on Page # 14
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calling “The Terminator.”  What I 
will do is wrap it up in colorful 
paper and donate it to the club for 
a prize at the next Christmas par-
ty.  I am hoping it will fall into 
a strong masculine hand that will 
teach this contemptible, spiteful, 
despicable creature how to behave 
in the presence of a lady.

There is no restriction against any non-profit group us-
ing this article as long as it is kept in context with proper 
credit given the author.  The Editorial Committee of the 
Association of Personal Computer User Groups (AP-
CUG), an international organization of which this group 
is a member, brings this article to you.

Continued from Page # 13
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New Federal Website Provides 
Users with Internet Safety and 

Security 
Information
By Ira Wilsker, APCUG Director; Columnist, The Examiner, 
Beaumont, TX; radio & TV show host
Iwilsker(at)apcug.net 

WEBSITES:
http://www.onguardonline.gov
http://www.onguardonline.gov/quiz
http://www.onguardonline.gov/stopthinkclick.
html
http://onguardonline.gov/filecomplaint.html
http://onguardonline.gov/tutorials 

The media has recently been rife with stories about 
internet scams, frauds, identity theft, pedophiles, and 
other malevolent occurrences that have happened on 
the internet. While there are many online resources 
providing informational websites to help prevent us 
from falling prey to internet victimization, a con-
sortium of  federal agencies has created “OnGuard 
Online” at www.onguardonline.gov. This consortium 
consists of  the Federal Trade Commission (FTC), the 
Department of  Homeland Security (DHS), United 
States Postal Inspection Service, the Department of  
Commerce (DOC), and the Securities and Exchange 

Commission (SEC).

Materials are provided on this website to inform and 
educate the computer user about several of  the most 
nefarious threats that commonly assail us as we en-
joy the abundance of  the internet. Topics currently 
covered are spyware, identity theft, phishing, spam 
scams, online shopping, P2P (Peer-to-Peer) file shar-
ing, and VoIP (Voice over Internet Protocol – internet 
telephony). There are also a series of  online quizzes 
(www.onguardonline.gov/quiz) where the user can 
test his knowledge on the 
security risks associated with these topics. A series of  
videos and tutorials on related topics, such as “Virus-
es and Worms”, and “Protect Your Privacy, Family, 
and PC” are also available at this site (onguardonline.
gov/tutorials). For those who have been victimized 
by internet miscreants, a resource is available to show 
the user where and how to file complaints with the 
appropriate federal and other agencies at onguardon-
line.gov/filecomplaint.html.

Spyware is defined at this site as “… software in-
stalled on your computer without your consent to 
monitor or control your computer use.” Spyware can 
be used to steal your identity or capture your user-
names, passwords, and account numbers (keylog-
gers); compile personal surfing profiles for directed 
advertising or other purpose (some forms of  tracking 
cookies); display unwanted pop-up ads, which may be 
pornographic (ad-ware), redirect the browser to other 
sites (browser hijacking); install unwanted links on the 
desktop or in the “favorites” or bookmarks; and a va-
riety of  other unwanted and possibly dangerous web 
related items. OnGuard Online provides links and in-
formation on removing spyware, and protecting your 
computer from spyware.

Identity theft is a scourge that may impact as many 
as 10 million Americans each year, according to some 
sources. The incidence of  identity theft through inter-
net tricks, such as “Phishing” (typically emails direct-
ing the user to an authentic looking but counterfeit 
website soliciting credit card information, PIN num-
bers, etc.); “Pharming” (changing data files or “hosts” 
on the computer to redirect intentional visits to fi-
nancial or commercial sites to counterfeit sites where 
valuable personal information is illicitly obtained) ac-
counts for an increasingly significant portion of  iden-
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tity theft. OnGuard Online provides information on 
how to protect yourself  from Phishing scams, and 
how to protect your identity while online, as well as 
instructions on dealing with identity theft if  victim-
ized.

Some internet security companies report that the 
amount of  spam, or unsolicited commercial email, 
can easily amount to 60 to 80 percent of  all emails 
sent. According to this website, details are provided 
on the major spam scams currently in circulation. 
The top 10 spam scams are: The “Nigerian” Email 
Scam (may also appear to be from Russia, Columbia, 
England, or other sources); Phishing; Work-at-Home 
Scams; Weight Loss Claims; Foreign Lotteries (Con-
gratulations, you are a winner in the Spanish 
/ British / Canadian Lottery!); Cure-All Products; 
Check Overpayment Scams (I have a large cashier’s 
check – cash it, keep some, and wire me the differ-
ence); Pay-in-Advance Credit Offers; Debt Relief; and 
Investment Schemes (buy this penny stock – it will 
quintuple in a few days). Sadly, many gullible internet 
users still fall for these scams enriching the crooks, 
and typically receiving nothing worthwhile in return.

Millions of  internet users shopped online during the 
holiday season, and still continue to do so at online 
retailers, or popular auction sites such as Ebay. While 
most online shoppers have been successful, and had 
few problems, there are also thousands who have 
been victimized to some degree by internet crooks. 
This site explains a series of  safe shopping tips, in-
cluding “Know who you’re dealing with; Know ex-
actly what you’re 
buying; Know what it will cost (including shipping, 
taxes, and other charges); Pay by credit or charge 
card; Check out the terms of  the deal; and Print and 
save records of  your online transactions.”

“Peer-to-peer (P2P) file-sharing allows users to share 
files online through an informal network of  comput-
ers running the same software.” People, especially 
children and college students, use these P2P networks 
to exchange software, music, videos, and other files. 
While there is much material that can legitimately be 
exchanged, P2P is also often a source of  spyware, vi-
ruses, and illicit and illegal copies of  pirated software, 
music, and other intellectual property. This site lists 
many of  the risks common 

with these P2P services, and how to safely utilize such 
services.

You have likely seen the ads on TV, as well as displays 
at the electronics and mass merchandising stores for 
“VoIP”, services that allow the broadband internet 
user to make local and long distance phone calls over 
the internet for a flat monthly fee. While expanding 
on popularity, the path has been bumpy, as some sub-
scribers have been dissatisfied with the service. Issues 
and service such as “911” calls, while addressed in 
regulations, are still not universally implemented on 
many VoIP systems. The OnGuard 
Online website also explains what many local VoIP 
users painfully found out 
during the recent spate of  hurricanes and other 
storms, that if  there is no power, or internet service is 
otherwise inaccessible, the VoIP services generally do 
not function, leaving the user without phone service.

The OnGuard Online site “Stop – Think – Click: 7 
Practices for Safer Computing” (onguardonline.gov/
stopthinkclick.html) reiterates the oft stated common 
sense warnings that all computer users should be 
aware of, and implement:

1. Protect your personal information. It’s valuable.
2. Know who you’re dealing with.
3. Use anti-virus software and a firewall, and update 
both regularly.
4. Make sure your operating system and Web browser 
are set up properly and 
update them regularly.
5. Protect your passwords.
6. Back up important files.
7. Learn who to contact if  something goes wrong on-
line.
If  the information on the OnGuard Online websites 
is utilized, we will all 
have a safer and more enjoyable internet experience.

There is no restriction against any non-profit group using this article 
as long as it is kept in context with proper credit given the author.  
The Editorial Committee of  the Association of  Personal Computer 
User Groups (APCUG), an international organization of  which 
this group is a member, brings this article to you.
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Among the most effective anti-spam programs are 
the ones that use some kind of approval based email 
management system.  They work by constructing a 
“white list” of permitted email addresses, accept-
ing mail from anyone on the list, and rejecting ev-
erything else.  The program initially sniffs through 
your contact list, inbox, and other email folders, 
organizes the email addresses it finds, asks you if 
you want to add or change anything, and the list is 
complete.  

From that moment on, any incoming email that is 
not on the list is considered to be spam, and is au-
tomatically exiled to a quarantine folder or wher-
ever you decided it should go during installation.   
The programs do work as advertised, which is both 
their greatest strength and their greatest weakness.  
Here’s what you need to know before installing one 
of these puppies. 

Scenario 1:  A friend you have lost contact with over 
the years sends you an email.  That friend’s email 
address is not on your white list.  Unless you have 
a quarantine folder where unapproved email is sent 
without automatically deleting it, you will never 
see this email.   You have to check your quarantine 
folder, at least occasionally, to see if there are any 
false positives residing in there with all the junk.  
How much time will this take?  Who knows?  None 
of the programs mention this in their promotional 
material or specification lists.  

Scenario 2:  You install a new program or device 
and run into difficulties.  The troubleshooting guide 
sends you to an email address where you can get 
a solution to your problem.  You remember to add 
the email address to your white list.  You wait for a 
reply, and wait, and wait.  What happened?

Your problem was given to a technical representa-

by Vinny La Bash, vlabash(at)home.com
Member of the Sarasota Personal Computer Users 
Group, Inc.
February 2006 issue of the Sarasota PC Monitor
www.spcug.org

Anti-Spam Programs – 
Do They Really Work?

tive who has an email address different from the 
general support address.  You don’t see the reply un-
less you check the quarantine email folder, assum-
ing that in your efforts to rid yourself of all spam 
you did not specify that anything not on your white 
list be automatically deleted.  

Scenario 3:  You order something from an online 
merchant and before your order is shipped the mer-
chant emails you to ask whether you want the white 
one or the black one.  The query has been rerouted 
to the quarantine folder because the person trying to 
contact you has an email address that is not on your 
white list.  

Scenario 4:  Your spouse sets up a Yahoo! Email ac-
count for the sole purpose of sending you a surprise 
Valentine’s Day email.   For no apparent reason you 
are getting the silent treatment.  You ask, “What’s 
wrong”?  Your spouse replies, “Nothing”.  

Scenario 5:  Your granddaughter just got an email 
address of her own.  She sends you a message, and 
can’t understand why you won’t answer.  She asks 
her parents “Why doesn’t grandpa love me any-
more”?  

We could go on, but you get the general idea.  
99.99% of all real spam will be banished from your 
sight, but the very few legitimate emails identified 
as spam will very likely be the ones you most want 
or need to see.  Some anti-spam programs have a 
“sender confirmation feature” that automatically 
sends a personalized notification to anyone whose 
message has been quarantined. Simply replying 
to the challenge causes the original message to be 
moved to your inbox, and allows their email address 
to be added to the white list. Legitimate senders can 
respond to these challenge messages, but suppose 
that for whatever reason they don’t.  Does a seven 
year old grandchild really understand why she needs 
a grandparent’s permission to send an email?  

What you end up with is a time-consuming process 
of back and forth emails.  Why should every email 
first contact have to be sent twice?  What a waste of 
time.  This might be acceptable if your email volume 
is very low, but who are we kidding.  Simply estab-
lishing an email account anywhere will get you a 
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boatload of spam.  ISP level filters are a joke.  How 
many essays do you want to compose explaining 
why someone needs “permission” to send you an 
email?   I don’t respond to challenge email.  Why 
should anyone respond to mine?    

You can check your quarantine folder regularly, but 
with the huge quantity of genuine spam generated 
and thrust upon us daily, it’s too easy to overlook 
a legitimate message.  When you finally delete the 
spam, there is a good chance that among the junk a 
valuable note is lost forever.  

After using one of these programs for several 
months, I decided that I would much rather delete 
spam manually, rather than run the risk of missing 
an important legitimate email.  No computer pro-
gram, no matter how expertly crafted or trained, 
can ultimately determine what emails I do or don’t 
want to read.  Even after being married for 38 years, 
my wife still can’t read my mind.  How do I expect 
a dumb computer to do it?

There is no restriction against any non-profit group 
using this article as long as it is kept in context with 
proper credit given the author.  The Editorial Com-
mittee of the Association of Personal Computer 
User Groups (APCUG), an international organiza-
tion of which this group is a member, brings this 
article to you.

b

Legal Bytes: Fair Use 
- Wherefore Art Thou 

Going?
By John Brewer, eMonitor, Computer 
Club of Oklahoma City

The news media is reporting the 
current brouhaha over electronic 
eavesdropping and surveillance of 
telephone calls, email, and Inter-
net searches. The US Senate is set 
to begin debate on whether Judge 
Samuel Alito is the right person to 
follow Justice Sandra Day O’Connor. 
Congress is debating how to manage 
recover in New Orleans, fund wars 
in Iraq and Afghanistan, and ad-
dress the reality of record defi-
cits in the federal budget. It is a 
good time for the entertainment in-
dustry to make an end run on “fair 
use.”

Fair use is a legal concept that 
permits the public to use copy-
righted content without paying for 
the use, subject to specific re-
strictions. The entertainment in-
dustry perceives “fair use” as tan-
tamount to theft by the unwashed 
and the unsaved. Draft legislation 
sponsored by the Recording Indus-
try Association of America (RIAA) 
and the Motion Picture Association 
of America (MPAA) is being prepared 
for filing in Congress.

The new legislation is being cir-
culated by Senator Gordon Smith 
(R-Ore).and is titled the “Digital 
Content Protection Act of 2006.” 
The Electronic Frontier Foundation 
(EFF) reports that “fair use” will 
be limited to “customary historic 

Continued on Page # 18
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use of broadcast content by consum-
ers to the extent such use is con-
sistent with applicable law” un-
der the DCPA. EFF continues, “had 
that been the law in 1970, there 
would never have been a VCR. Had 
it been the law in 1990, no TiVo; 
in 2000, no iPod. “Fair use” has 
always been a forward-looking doc-
trine. It was meant to leave room 
for new uses, not merely customary 
historic uses. Sony was entitled to 
build the VCR first and resolve the 
fair use questions later.”

EFF interprets the proposed legis-
lation as giving regulators (that 
could be largely staffed by indus-
try types) the power to prohibit new 
technologies in advance of their 
introduction to public use. Past 
practice was to permit the intro-
duction of new technology and then 
permit the courts to rule whether 
copyright law was applicable and, 
if so, whether the use of the tech-
nology was an exception under “fair 
use.” As an example, the public is 
permitted to tape a television pro-
gram on a VCR and play it back later 
as a “fair use” exception to copy-
right law. This practice is called 
“time shifting.”

The new law will permit the device 
or technology only if it meets the 
criteria of “customary historic 
use.” New technology will probably 
not qualify as “customary historic 
use.” EFF predicts a world where 
technology will be frozen in time 
because industry lobbyists will have 
the power to prohibit new technol-
ogy. Anyone who thinks otherwise 
is naïve. The federal regulatory 
agencies have seen “sea changes” in 
their attitudes under the current 
administration in the determina-

tion of the proper balance between 
industry and public interests.

The Public Knowledge web site states 
that the Smith legislation is basi-
cally a rework of what is known as 
the “Hollings Bill” from 2002. Pub-
lic Knowledge states further “the 
fact remains that the main issue 
here is not about piracy, it’s about 
control. The content industry needs 
a congressional mandate to control 
the functionality of consumer elec-
tronics and PCs, and in turn, what 
consumers can do with the devices 
and content they legally obtain.

The Senate has introduced the 
“Digital Content Protection Act 
of 2006,” a bill that will create 
“Broadcast Flags” for all digital 
radio and television, leading to 
FCC oversight of all new digital 
media technologies from iPods and 
PSPs to TVs and DVD recorders.”

Another web site, a very interesting 
web site indeed, is boingboing.net. 
Boingboing has the following to say 
about the Smith legislation.

“Under the DCPA proposal, digital 
media technologies would be re-
stricted to using technologies that 
had been certified by the FCC as 
being not unduly disruptive to en-
tertainment industry business-mod-
els. There are two things to be 
certain of this century:

1. Everything that can be expressed 
as bits [digital content] will be 
expressed as bits 
2. Bits will only get easier to 
copy 

The entertainment companies are 
convinced that their businesses de-
pend on copy-proof bits. This is 
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ridiculous: there’s no such thing, 
there never will be.

Governments that try to protect 
businesses that demand copy-proof 
bits are like governments that try 
to protect businesses on the sides 
of volcanoes, who demand an im-
mediate end to business-disrupting 
lava.

If the current entertainment com-
panies can’t or won’t adapt to a 
world of bits, that’s too bad. Let 
them die, and let new businesses 
that thrive in the new technologi-
cal reality take their place. If 
you can’t stand the heat, get off 
the volcano.

Back in the mainframe days, IBM made 
its money by giving away comput-
ers below cost and then charging a 
bundle for keyboards and printers. 
Hitachi killed the mainframe busi-
ness by introducing cheap periph-
erals for IBM mainframes. Killing 
mainframes didn’t kill computers: 
it made them better. IBM was forced 
to get into the minicomputer busi-
ness, which led to the personal 
computer.

If computer industry complaints got 
the same attention as the entertain-
ment crybabies get from lawmakers, 
there’d be 10,000 computers total 
in the world, running punchcards, 
with three companies making modest 
sums servicing them and shipping a 
new model every three years.

Hollywood’s crybaby capitalists ac-
cuse us of being “communists” with 
one breath, and in the next, they 
go begging to Congress to turn the 
FCC into device czars who keep the 
market from being disrupted by in-
novation.

Andy Setos, the Fox executive who 
invented the Broadcast Flag, once 
told me that his objective was “a 
well-mannered marketplace.” The en-
tertainment industry’s version of 
a planned economy is bad policy.

Send a strong signal to your law-
maker: if you break my TV, radio, 
and computer, I will campaign tire-
lessly for anyone who will promise 
to throw you out of office and undo 
your deeds.

The author of the new bill to break 
our televisions, computers, and mp3 
players, Senator Gordon Smith of 
Oregon, has been paid tens of thou-
sands of dollars to do it. The Na-
tional Association of Broadcasters 
(NAB) has been lobbying hard for 
the sole ability to decide how hard 
it’s going be for us to listen to 
an mp3. The NAB has thrown nearly 
$250,000 at Republican candidates 
this year alone. NAB’s money stuck 
to Gordon Smith.” 

Sometimes the public has live with 
the legislation that has been 
bought by industry. Anyone who is 
concerned should make their voice 
heard.
 
John Brewer practices law in Okla-
homa City, is a member of the Gov-
ernor’s and Legislative Task Force 
for E-Commerce, and enjoys issues 
relating to eBusiness and cyber-
space. Comments and questions are 
welcome and can be emailed to johnb@
jnbrewer.com.

In accordance with Title 17 U.S.C. 
Section 107, this material is dis-
tributed without profit to those 
who have expressed a prior interest 



February 2006
ORANGE COAST IBM PC USER GROUP

Readme.doc ver 22.02

20

Continued from Page # 19

in receiving the included informa-
tion for research and educational 
purposes. The article may contain 
sources for content as attributed 
within the article.

There is no restriction against any 
non-profit group using this arti-
cle as long as it is kept in con-
text with proper credit given the 
author.  The Editorial Committee of 
the Association of Personal Com-
puter User Groups (APCUG), an in-
ternational organization of which 
this group is a member, brings this 
article to you.
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The Shadow Knows
by Mike Morris
Front Range PC Users Group, Fort Collins, CO
www.frpcug.org
ml_morris(at)jymis.com

How many readers remember that phrase?  Or re-
member listening to the show on the radio:

“Who knows what evil lurks in the heart of men?  
The Shadow knows.”

Recent headlines have described the availability of 
TV shows on the internet—at a price.  No head-
lines, however, for The Shadow or other radio pro-
grams from the 1930’s and 1940’s.  The copyrights 
to a large number of the old radio shows have ex-
pired, and you can now download (or order) these 
programs in a variety of formats and listen to them 
through your computer or other audio equipment.

Whether your interest is historical research, for the 
nostalgia value, for a hobby, or for the simple enter-
tainment value, the variety of programs and infor-

mation about these old radio programs is astonish-
ing.  I originally searched the internet using Google 
and the phrase “old radio programs.”  That search 
returned over 20,000 hits over 6 months.  The cor-
rect phrase should have been “old time radio.”  That 
search returned over 1 million hits from the past 6 
months.

These websites provide an incredible wealth of in-
formation.  I have checked a very small number of 
websites, and offer my comments on them.  There 
are episodes of The Shadow, Sam Spade, The Thin 
Man—as you can see, I like mysteries.  There are 
comedies, westerns, music, and much more.

By the way, how many readers remember the origin 
of Sam Spade?  Do you recall the movie “The Mal-
tese Falcon” with Humphrey Bogart?  The movie 
was based on the novel of the same name by Dashi-
ell Hammett (originally published in 1929), which 
introduced the world to Sam Spade.  Another novel 
by the same author, “The Thin Man,” (originally 
published in 1933) was turned into a move starring 
William Powell and Myrna Loy.  Here is a trivia 
question for you:  who really was the Thin Man?—
answer at the end of this article.

As you might expect, the audio quality of these old 
radio shows varies.  Some websites allow you to lis-
ten to short samples of selected shows using either 
RealPlayer™ or Media Player, both of which are 
bundled with the Windows operating system.

“It is Thursday night, July 31,1930. The time is 9:40 
PM. Radio listeners tuned to CBS hear the first ap-
pearance of “The Shadow” . . . .”  Thus begins the 
history of “The Shadow” as provided by the Old-
Time Radio Program Guide, http://www.old-time.
com/toc.html.  This website has links to historical 
information on a number of old time radio programs 
and to other websites that include soundbites and 
stories, and to websites that offer programs on cas-
settes, CD’s, DVD’s, or direct downloads to your 
computer.

More history is available at Radio Days: A Sound-
bite of History, http://otr.com/index.shtml.  There 
are links to history by category (Mystery, Private 
Eyes, Comedy, SciFi) and to histories of selected 
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programs (Captain Midnight, Terry and the Pi-
rates).  This website also provides an historical 
timeline with important dates in radio broadcasting 
with descriptions of relevant programs.  Selected 
downloads (soundbites) are included.  There is a 
link to a schedule of old time radio on the airwaves 
(and on the internet).

At “It Seems Like Only Yesterday,” http://www.
yesterdayradio.com/, old radio programs are offered 
for sale on cassettes.  Categories include: World 
War II and Civil War History, Big Band Music, 
Comedy, Westerns, Science Fiction, and Sherlock 
Holmes.  The Big Band category includes Glenn 
Miller, Benny Goodman, Tommy Dorsey, and other 
broadcasts from the 1940’s.

The “Radio of Yesteryear” website, http://www.
originaloldradio.com/, claims to have 50,000 old 
time radio programs available on CD’s, in various 
formats.  There is a category called “Radio’s Best 
1000,” and “single subject” CD’s such as Abbott 
and Costello, CBS Radio Mystery Theatre, and 
many more.

Meanwhile, back at . . . old-time.com, there is a link 
to a website called “Radio Showcase,” http://www.
old-time.com/sponsors/rad_sho.html.  This site of-
fers an excellent searchable database, with “actor 
credits, recording sources, story categories, and 
program notes . . . .”  Here is a sample of a search:

Here is a sample of the results of the search:

In the interest of objectivity, I call your attention 
to the RadioLovers.com website, http://radiolovers.
com.  This site claims to offer individual old time 
radio program downloads.  However, I did not pur-
sue the offer.  I found the site’s use of pop up ads 
objectionable (the ads appeared despite having the 
pop up blocker enabled in my Firefox browser).  
But that is my personal prejudice.  For those with 
greater tolerance to such ads, you may find this site 
useful.

As I listened to these old radio programs, and read 
about their history, I realized that there was one pro-
gram that I wanted to locate above all others:  the 
original radio broadcast of War of the Worlds.  This 
program, created from the 1898 H. G. Wells novel 
by Orson Welles and broadcast in 1938, is famous 
(or infamous) for the real panic it created.

A search using Google on the phrase “war of the 
worlds” provided the result EarthStation1.com, 
http://www.earthstation1.com/wotw.html.  Success!  
I listened to the entire program (slightly less than 
one hour) using RealPlayer™.  My brain soaked up 
certain phrases:

“. . . these creatures have scientific knowledge far in 
excess of our own . . . .”

“. . . a vanguard of an invading army from Mars . . 
. .”

Okay, so point your finger at me and laugh, while 
you enjoy the latest movie version with its extraor-
dinary computer generated special effects.  I thor-
oughly enjoyed the hour I spent listening to this 
classic radio broadcast.  Even the 1930’s audio 
quality added to its menace.



February 2006
ORANGE COAST IBM PC USER GROUP

Readme.doc ver 22.02

22

Continued from Page # 21

While you are watching the movie, I am going to 
dim the lights, turn off the TV, unplug the phone, 
and settle into my favorite chair.  It is time to listen 
to The Shadow.  Even in the 21st century, it is com-
forting that there is an answer to the question “who 
knows what evil lurks in the heart of men?

The Shadow knows.”

[The trivia question answer:  No, it is not the detec-
tive Nick Charles.  The title of Thin Man belongs 
to the extremely eccentric inventor Clyde Wynant, 
who remains missing until the last chapter of the 
novel, when it is revealed that he is the victim of a 
gruesome crime.]

There is no restriction against any non-profit group 
using this article as long as it is kept in context with 
proper credit given the author.  The Editorial Com-
mittee of the Association of Personal Computer 
User Groups (APCUG), an international organiza-
tion of which this group is a member, brings this 
article to you.

c

An End to 
Computer 

Annoyances
By Gabriel Goldberg, APCUG Advisor; Columnist, AARP 
Computer & Technology Website, www.aarp.org

Many of us have mixed relationships with 
computers and technology. They enrich 
our lives but can be maddening at times. 
Books and magazines often tell us how 
great they are, but an O’Reilly book series 

addresses the dark side of the story by de-
scribing their annoyances and offers “help 
for newbies and powerusers alike.”

The format of the books is similar to Q&A 
dialogues or lists of FAQs (frequently asked 
questions). They’re not meant to be read 
from cover to cover but explored based on 
a particular need or curiosity. This search 
is assisted by good tables of contents and 
full indexes. The books are written in con-
versational English, pairing annoyances 
with their fixes, and include an abundant 
amount of clear and helpful screen shots.

While flipping through these books, the 
handy tips boxes lead to many “aha” mo-
ments and I was able to identify many 
solutions to current and future problems. 
Some of the content overlaps between 
books, such as Internet topics being ad-
dressed in its own book, Internet Annoy-
ances, also being mentioned in both PC 
Annoyances and Home Networking An-
noyances. You may want to read a gen-
eral book along with those specific titles 
that address your main interests. Some 
books are in their second edition, making 
it worthwhile to check print dates and edi-
tion numbers before purchasing them.

Steve Bass, author of PC Annoyances, 
provides a good introduction, stating 
that “Many people are now realizing that 
they’ve been putting up with programs that 
have downright annoying features and 
yes, bugs. It’s high time they learned they 
aren’t alone, it’s not their fault, and, most 
important, there are solutions and work-
arounds.”

Bass’ book isn’t overly technical. It address-
es topics such as e-mail, Windows, the In-
ternet, Microsoft Office, Windows Explorer, 
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music, video, CDs, and hardware. Many 
all-too-common problems are identified 
and solved, but it’s not all-inclusive. For 
example, it doesn’t mention Thunderbird 
e-mail or Firefox browser, both of which 
I like a lot, but they can be annoying too! 
Coverage of Windows XP SP2 is localized 
and not mentioned places where it would 
be appropriate. Varied software is recom-
mended, free and purchased, downloaded 
and store-bought, and advice is provided 
on configuring Windows and applications. 
And non-annoyance bonus material, such 
as “IM Netiquette rules,” which was both 
entertaining and valuable. I was happy 
to learn how adding a work menu to MS 
Word gives instant access to frequently-
used documents.

Another book in this series, PC Hardware 
Annoyances, covers diverse topics includ-
ing computer setup, keyboard, mouse, 
startup, BIOS/CMOS, memory, processor, 
maintenance, and battery. Some annoy-
ances are offered up as questions, such 
as “Do I need specialized PC cleaning 
supplies?” The helpful and short answer 
is “no”, since common materials, used ap-
propriately, work just fine. Because every-
one has unique interests and concerns, 
even the book’s specialized items are 
useful and thought provoking.

Other Annoyances titles address com-
puter privacy, home networking, the Inter-
net, the Mac, Windows XP for geeks, and 
some Microsoft applications (Access, Ex-
cel, and Word), all of which are listed on 
the O’Reilly Annoyances Central Web site. 
This site also offers additional resources 
to combat computer-related annoyances 
with it’s Experts’ Blogs (a good way to get 
your unique questions answered before 
they appear in a book), the Daily Fix (a 

stream of individual items from the books), 
and Robert’s Rant (the slow-paced blog of 
Robert Luhn, the Annoyances series Ex-
ecutive Editor, who addresses topics such 
as whether Wikis can be trusted and the 
origin of his book series).

Specifications
Title: PC Annoyances
Author: Steve Bass
Paperback: 252 pages
Publisher: O’Reilly Media
ISBN: 0596008821
Price: $19.95

Title: PC Hardware Annoyances
Author: Stephen J. Bigelow
Paperback: 266 pages
Publisher: O’Reilly Media
ISBN: 0596007159
Price: $24.95

This article originated on AARP’s Computers 
and Technology Web site, 
www.aarp.org/computers, and is copyrighted 
by AARP. All rights are reserved; it may be 
reproduced, downloaded, disseminated, or 
transferred, for single use, or by nonprofit or-
ganizations for educational purposes, with at-
tribution to AARP. It should be unchanged and 
this paragraph included. Please e-mail Gabe 
Goldberg at
gabe(at)gabegold.com when you use it, or for 
permission to excerpt or condense.

There is no restriction against any non-profit 
group using this article as long as it is kept in 
context with proper credit given the author.  
The Editorial Committee of the Association of 
Personal Computer User Groups (APCUG), an 
international organization of which this group is 
a member, brings this article to you.



February 2006
ORANGE COAST IBM PC USER GROUP

Readme.doc ver 22.02

24
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OCIPUG
Costa Mesa Senior Center
695 W. 19th St
Costa Mesa, CA 92627

OCIPUG, founded in 1985, is an independent California nonprofit
(IRC 501-c-3) corporation, and is not affiliated in any way with IBM,
any vendor, equipment manufacturer, or other organization.

Publication Copyright © 2005
A newsletter, Readme.Doc, is published monthly. A subscription of $12
per year is included with all paid memberships. Address all inquiries,
address changes, and material for publication to the above address
marked “ ATTN:Editor”.

Opinions expressed by the authors are not necessarily those of this
newsletter, its staff or OCIPUG. Mention of products does not
constitute endorsement by OCIPUG. Omission of trademarks does not
imply that the products or names are not so protected. Readme.Doc, its
contributors, and staff assume no liability for damages arising out of the
publication or nonpublication of any advertisement, article, or any other
item in this newsletter. Permission is granted to other user groups to
reprint herein material, not specifically copyrighted, for non-commercial
use only, provided credit given to Readme.Doc and to the author.

Publication Deadline
Material for the next issue must be received by the editor at editor@ocipug.
org on or before 7 days following the General Meeting of the month prior.

Publication Guidelines
All material submitted will be published exactly as submitted, but may 
be subject to editing at the Editor’s discretion. We reserve the right to 
refuse any material submitted for publication.

Orange Coast IBM PC User Group
695 W. 19th St

Costa Mesa, CA 92627
Southeast Corner of 19th and Pomona

Membership status: [  ] New [  ] Renewal - Member #________
Membership type: [  ] Individual [  ] Family

Title: Mr. Mrs. Ms. Dr. Prof. Hon. (  ) (Circle one)
First Name: _____________________________ Last Name:_________________________________
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Home Phone:(      )_______________ Work Phone: (      )_____________ Fax: (      ) ______________
E-mail address: _____________________________________________________________________
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Family Member(s) Names: _____________________________________ Company: ______________

Annual Dues:
Make check payable to OCIPUG and mail to the above address or bring to the General Meeting.
Individual 1 year $30.00 $ ________, 2 years $55.00 $_________, 3 years $75.00 $__________

Family 1 year $35.00 $ ________, 2 years $60.00 $ ________, 3 years $85.00 $ __________
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I learned about OCIPUG from: _______________________
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      1. Send via Internet e-mail to: editor at editor@ocipug.org
      2. Mail a 3.5” disk so as to be received by the deadline by the
          Newsletter Coordinator at the OCIPUG mailing address above.
      3. Hard copy to Editor at the OCIPUG mailing address above.

Membership
Benefits of OCIPUG Membership include, but not limited to:
     * Subscription to OCIPUG’s monthly newsletter,
        Readme.Doc, with up to-date information on meeting
        schedules as well as the newest software and hardware.
     * Free monthly General Meetings with speakers from
        industry and academia describing advances in technology.
     * Free Special Interest Group (SIG) meetings/seminars to
        exchange tips and tricks and to solve problems.
     * Free technical support from knowledgeable
        fellow members via telephone and/or e-mail.
     * Pleasure in helping your fellow member solve their problems.
     * Camaraderie with those of similar interests.
     * Discounts from vendors on software, hardware, and other items.
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Costa Mesa, Ca
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